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Overview 

 

The following pricers and models are available for pricing Commodities. Details of the models are described in 
subsequent chapters. 

Pricer Product Type supported Valuation Model 

PricerCommodityForward CommodityForward Deterministic 

PricerCommoditySwap2 CommoditySwap2 Deterministic 

PricerCommodity Commodity Deterministic 

PricerCommodityCertificate CommodityCertificate Deterministic 

PricerCommodityIndexSwap CommodityIndexSwap Deterministic 

PricerFutureOptionCommodity FutureOption (Commodity) Black 76 

PricerCommodityOTCOption2Clewlow CommodityOTCOption2 Black 76 (Clewlow approximation for 
Asian) 

PricerCommodityOTCOption2LTBlack CommodityOTCOption2 Black 76 (Levy-Turnbull Asian Volatility 
Approximation) 

PricerCommoditySwaption2 CommoditySwap Black 76 

 

The following market data item generators are available for pricing Commodities. Details of the generators are 
described in subsequent chapters. 

MarketDataItem Generator Description 

CurveCommodity Commodity Generates output in terms of implied 
future prices. 

CurveCommodity CommoditySwap Generates output in terms of implied 
Monthly Asian swap prices. 

CurveCommoditySpread CommoditySpreadAllInPoints Generates output by adding a spread 
value to the output points of the base 
curve. 
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MarketDataItem Generator Description 

CurveCommoditySpread MonthlyAsianSwapSpread Generates output by first calculating 
implied Asian swap prices and then 
adding a spread value to the swap 
price. 

ConvenienceYieldCurve ConvenienceYield Used to generate a 3-D pricing surface 
with axes of price, date and hour. 

HyperSurface CommodityElectricity Generates a volatility surface using 
input points defined as the implied 
volatility of ATM future options and 
spreads to the ATM for the wings. 

VolatilitySurface CommodityDelta Generates output by combining a 
commodity spot price, a commodity 
convenience yield curve and a zero 
curve in the quoting currency of the 
commodity. 

VolatilitySurface CommodityVolatilitySpread Generates a volatility surface by adding 
a spread value to the output points of a 
commodity volatility surface. 

VolatilitySurface CommoditySimple Generates a simple volatility surface 
using absolute or relative strikes and 
manually entered expiry tenors 

 



Nasdaq Calypso 
Commodities Analytics / Version 18 

 

 

 

 

February 2024 Revision 1.0 / Approved Page 6 / 29 
Private and Confidential 

 

Commodity Curves 
Calypso users are able to create forward curves using standard generation techniques, customise interpolation 
methods, create expiry calendars and are easily able to add new commodities and market conventions. 

 

The commodity forward curve analytics are accessed from Market Data > Commodity Curves > Forward Curve. 

 

Figure 1 – Opening forward curve analytics 

 

When the commodity forward curve window is opened the user is presented with the window shown in Figure 2. 
Clicking the ... button allows the user to select the commodity for which a forward curve is to be generated. 
Through FastTrack database setup there is a comprehensive list of commodity details pre-installed. All of the pre-
loaded details can be edited and added to through the commodity editor shown in Figure 3 – Commodity editor. 

Selecting File > New clears all fields so that a new commodity can be entered, to create a new commodity name 
click the ... button, enter the name in the left entry box, then pass it to the right by clicking >>, to save. Upon 
returning to the commodity selection box the created commodity is selectable from the drop down list.  

The Settings section creates the attributes for the named commodity. Figure 3 – Commodity editor shows the 
details for WTI Crude Oil, which is stockpiled in Cushing, OK, measured in Barrels and sold through the NYMEX. For 
commodities that might be quoted in different units by either counterparty Calypso allows entry of conversions that 
when priced will display in your conventional unit. An example might be a trade where one counterparty trades 
Cotton in MTonnes while the other would prefer Pounds, to accommodate this the user can enter commodity 
conversions by going through Configuration > Commodities > Commodity Conversion..., see Figure 4 - Unit 
conversion. The effect of this would be that if we were to price our futures in $/US Gallon rather than $/Barrel, our 
forward curve points would be a factor of 42 smaller as shown in Figure 5 - Curve points shown in $/US Gallon. 
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Figure 2 - Commodity forward curve definition tab 

 

Figure 3 – Commodity editor 
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Figure 4 - Unit conversion 

 

Figure 5 - Curve points shown in $/US Gallon 

 

The "Commodity" forward curve generation algorithm is our most simple generator. The underlying’s supported in 
this generator (in v11.1.04) are Futures, Commodity Forward Points, Monthly Asian Swaps, Future Calendar 
Spreads, Swap Roll Spreads and Spot.  The generator places these underlying in three categories in order to 
generate output. 
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Some underlying’s are used to generate output as a simple function of input date and price attributes.  This 
function simply finds the curve date and the market quote of the underlying and generates an output point with 
that date and price.  This logic applies to Future, Commodity Forward Point and Monthly Asian Swap underlying’s. 

Some underlying’s represent the relative prices of two chronologically adjacent underlying’s.  These are referred to 
as Calendar Spreads or Swap Rolls, and represent a price spread between two future or swap underlying’s. 

 

CommoditySwap generator calculates the average price P of a commodity over a period, T that is based upon 
underlying quotes Qi, which are valid for n sub period’s of length τi. The generic equation for this is 

𝑃 = 
∑ 𝑄𝑖𝜏𝑖
𝑛
𝑖=1

𝑇
 

Equation 1 

The period P might be a calendar month for commodity swaps that do not expire at the end of a calendar month 
and inside that calendar month if there is one expiry there are two distinct sub periods that are bounded by the 
expiry and the beginning and end of the month respectively. The quotes Q1 and Q2 are set based upon the forward 
price method selected (in this case WTI Nearby). 

A simple example of this is the WTI Crude Oil curve. Using the Nearby forward price method the curve may be 
constructed from Futures quotes for monthly crude swap quotes on their expiry dates, which are the third business 
day prior to the last business day preceding the twenty-fifth calendar day (CME Group, 2011).  

Taking the example of a WTI crude price calculation for September 2011, quotes are taken from September and 
October Futures, if these are $99 for September and $100 for October we would obtain an August 31st value of 
$99.3 (since we are averaging over the month of August) based upon formula. 

An example of the Quotes and their calculated points, as displayed in Calypso, are shown in Figure 6 - Selected 
quotes for WTI Crude Oil Futures and Figure 7 - Points calculated from Equation 1. 



Nasdaq Calypso 
Commodities Analytics / Version 18 

 

 

 

 

February 2024 Revision 1.0 / Approved Page 10 / 29 
Private and Confidential 

 

 

Figure 6 - Selected quotes for WTI Crude Oil Futures 

 

Figure 7 - Points calculated from Equation 1 

 

The commodity spread curve generation window is opened from Market Data > Commodity Curves > Spread 
Curve. 

Spread curves are used to price illiquid commodities that are quoted in terms of spread to a more commonly traded 
commodity, or spreads, between the same commodity at different expiries. 
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Figure 8 – Commodity spread curve definition tab 

 

The Monthly Asian Swap Spread curve generator is available from the spread curve window when the Generate 
from instruments tick box is selected. 

The underlying instruments are selected in the Underlying’s tab and can be either Commodity Spreads or 
Commodity Forward Points. When creating the curve from commodity spreads the spreads are simply added onto 
the base commodity price that is calculated from Equation 1 in PricerCommoditySwap. So that the Spread points 
can be shown to be: 

SpreadPPSpread +=  

Equation 2 

The price of Middle East Sour is often quoted as a spread against WTI, or Brent, which means that a Middle East 
Sour curve has to be created from the more liquid commodity curves. Calypso allows this through the introduction 
of a base curve on the Spread window. Figure 8 shows the Calypso definition tab for this example. The Generation 
Alg. dropdown allows for the selection of MonthlyAsianSwapSpread. 

Clicking on the ‘Underlyings’ tab gives a choice CommoditySpread or CommodityFwdPoint, either of which can be 
used to create the spread curve. In this example 12 month of Middle East Crude Sour Oil spread underlying have 
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been created and quotes have been entered in the usual way; either the quotes tab or through Market Data > 
Market Quotes. 

The ‘Points’ tab shows the calculated prices; see Figure 10 – Spread curve calculated points. Note the relationship 
between the points calculated in Figure 7 - Points calculated from Equation 1, Figure 9 - Spread quotes and Figure 
10 – Spread curve calculated points. 

 

Figure 9 - Spread quotes 

 

Figure 10 – Spread curve calculated points 

CME Group. (2011). Light Sweet Crude contract specifications. Retrieved from www.cmegroup.com: 
http://www.cmegroup.com/trading/energy/crude-oil/light-sweet-crude\_contract\_specifications.html. 
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Pricers 

 

Price (CertificateCommodity) = (CommodityMarketPrice – storageCost – gradeDiff – locationDiff - fees) * df –
AccrualStorageCost. 

 

In this section we derive the equations in the paper A Model for Metal Exchange Average Price Option Contracts by 
Les Clewlow, August 1997. The paper specifies a pricing and risk management model for London Metal Exchange 
(LME) Average Price Option Contracts. These LME options are Asian options of European exercise type on the 
Monthly Average Settlement Price (MASP). 

Introduction 

We assume that he asset price at time t  given by 
tS follows a geometric Brownian motion with drift  and volatility 

 . The stochastic differential equation of 
tS is 

 
t t t tdS S dt S dZ = + , (3) 

where 
tdZ is the increment in the Brownian motion. The value of ln TS for some time T t has a normal distribution 

(.,.)N , 

 ln ( , )TS N a b  (4) 

where the mean a and variance b are respectively given by 

 
21

2

2

ln ( )( )

( )

ta S T t

b T t

 



= + − −

= −
 (5) 

If the asset pays a continuous dividend yield d , the process of the asset  Eqn. (1) becomes 

 ( )t t t tdS d S dt S dZ = − + . (6) 

In the risk neutral world the process for 
tS becomes 

 ( )t t t tdS r d S dt S dZ= − +  (7) 

where the real world drift  is replaced by the risk-free rate r , and tdZ is the Brownian increment in the risk-neutral 

world. The mean and variance in the risk-neutral world are 
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21

2

2

ln ( )( )

( )

ta S r T t

b T t





= + − −

= −
 (8) 

Note that the volatility remains unchanged so that the variance remains the same in the new measure. 

Standard Black-Scholes theory gives us that the price of a European call option on the asset 
tS with payoff function, 

max( ,0)TS K−  at expiry T is 

 ( )
1
2( )

1 2( , ) ( ) ( )
a br T t

tC S t e e N d KN d
+− −= −  (9) 

where K is the strike of the option and the arguments to the cumulative normal (.)N are 

 
1

2 1

ln
,

a K b
d

b

d d b

− +
=

= −

 (10) 

Within the Black-Scholes framework the forward price at time t , ( )tF T of the asset is simply related to the spot price 

tS by 

   ( )( )( ) r d T t

t T tF T E S S e − −= = , (11) 

where the expectation [.]E is taken in the risk-neutral measure. 

Let 
1 2, , , nS S S be the price of the asset at different times up to the expiry time T . We define the arithmetic and 

geometric averages as follows, 

Arithmetic Average: 

 

1

1 n

T k

k

A S
n =

=   (12) 

Geometric Average: 

 

1

1

n n

T k

k

G S
=

 
=  
 
 . (13) 

Using Jensen’s inequality it can be shown that 

 
T TG A  (14) 

where the equality holds only when all the asset price observations assume the same values
1 2 nS S S= = = . 
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A nice property of the geometric average of asset prices is that the dynamics of this type of average is also log-

normally distributed. It follows that we can evaluate a call option on the underlying 
TG with payoff max( ,0)TG K−

within the standard Black-Scholes framework. On the other hand the arithmetic average 
TA does not have a simple 

distribution – so in order to arrive at an analytical solution for the call option on 
TA we have to resort to some 

approximation. The essence of the Clewlow model lies in approximating the distribution of 
TA by the log-normal 

distribution. Simulation studies indicate that this is a reasonable approximation if the volatility  is not too high (say 

40% ). 

 

Put-Call Parity 

Independent of the dynamics assumed for the underlying, no-arbitrage conditions require that put-call parity holds. 

Denote the price of a call and put option on the arithmetic average by ( )AC t and ( )AP t respectively. The strike and 

expiry are the same for the call and the put. Consider the portfolio where we go long a call option and short a put 

option. At expiry we have two states of the world; either 
TA K or

TA K . It is easy to see that the portfolio gives 

identical payoffs in either state of the world – 

 

( ) 0,
( ) ( )

0 ( ),

T T

A A

T T

A K A K
C T P t

K A A K

− + 
− = 

− − 
 (15) 

no matter what happens we have the same payoff: 

 ( ) ( )A A TC T P t A K− = −  (16) 

What would one pay for a certain payoff at time T at an earlier time t ? We would by the no-arbitrage principle simply 
pay its discounted value at the risk-free rate. It follows that: 

  
1 1

1
( ) ( ) exp ( ) ( )

m n

A A i t k

k k m

C t P t r T t S F t K
n = = +

  
− = − − + −  

  
  , (17) 

where the forward prices are given by Eqn. (9).  

 

At the earlier time t , out of n observations only the first m are known. 
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Model in Detail 

The payoff at expiry of an average price call option (APO call) is given by 

 max( ,0)TA K−  (18) 

In what follows it will be convenient to separate out at any given time t , the known part of the asset price average. 

If at time t we have that 
1 2, , , mS S S are known then we let 

 
1

1

1

1

m

k k

k

n

T k

k m

A S
n

M S
n

=

= +

=

=




 (19) 

where the known part of the average is 
kA  and the unknown stochastic component of the average is 

TM . We can 

express the payoff at expiry in terms of a strike that is adjusted by the known component of the average, 

 max( ,0)TM K−  (20) 

where 

 
kK K A= − . (21) 

 

Now we apply the key assumption of the Clewlow model – we assume that 
TM is log-normally distributed, 

 ln ( , )TM N a b . (22) 

A lognormal variable such as 
TM  has moments given by 

 
2exp

2

k

T

b
E M ka k

 
  = +  

 
 (23) 

A derivation of the lognormal moments is given in Appendix A. 

Using Eqn. (21) we have that, 
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   1
2

ln TE M a b= +  (24) 

 2ln 2 2TE M a b  = +   (25) 

We have a system of two equations in two unknowns a and b . Solving for the unknowns we arrive at, 

   21
2

2ln lnT Ta E M E M = −    (26) 

   22ln lnT Tb E M E M = − +    (27) 

Now we proceed to calculate the first two moments of the stochastic component of the arithmetic average 

 ( )2

1 2

1
T m m nM S S S

n
+ += + + +  (28) 

We can rewrite this as 

 ( )2

1 1 2 1 2 3

1
T t m t m m t m m m nM S x S x x S x x x x

n
+ + + + + += + + +   (29) 

where each 
ix evolves the initial asset price forward over a time interval 

it . 

 

 
21

2
exp(( ) )i i i ix r d t t z = − −  +   (30) 

where 
iz is a normal variate and 

iz is independent of 
jz if i j . It follows that the 

ix ’s are independent, log-normally distributed 

random variables.  Using the results from Appendix A with ( ) ia r d t= −  and 
ib t=  we have that the first two moments of 

ix

are 

   ( )exp ( )i iE x r d t= −   (31) 
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and 

 ( )2 2exp (2( ) )i iE x r d t  = − +   . (32) 

Taking the expectation of Eqn. (27) we obtain 

 

             ( )

   

1 1 2 1 2

1

1

t
T m m m m m n

n
t

m k

k m

S
E M E x E x E x E x E x E x

n

S
E x E x

n

+ + + + +

+

= +

= + + +

= 
 (33) 

Substituting for the expectation using Eqn. (29) we have that 

 

  ( ) ( )(

( ))

1 1 2

1 2 3

1 1

exp ( ) exp ( ) ( )

exp ( ) ( )

exp ( ) .

t
T m m m

m m m n

n k
t

j

k m j m

S
E M r d t r d t t

n

r d t t t t

S
r d t

n

+ + +

+ + +

= + = +

= −  + −   +  +

+ −   +  +  + + 

 
= −   

 
 

 (34) 

Taking the square of Eqn. (27) we have, 

 
(

)

2

2 2

1 2 2 3 2 3 4

2

2 3 4 5

1t
T m m m m m m m

m m m m n

S
M x x x x x x x

n

x x x x x

+ + + + + + +

+ + + +

 
= + + + + 
 

+

 (35) 

The expectation is given by 

 

 

(

)

2

2 2

1 2 2 3 2 3 4

2

2 3 4 5

1t
T m m m m m m m

m m m m n

S
E M E x E x x x x x x

n

x x x x x

+ + + + + + +

+ + + +

 
   = + + + +     

 

+


 (36) 

Substituting for 2

1mE x +
   we obtain 

 

( )

( )

2

2 2

1

2

2 2 3 2 3 4

exp (2( ) )

1

t
T m

m m m m m m n

S
E M r d t

n

E x x x x x x x

 +

+ + + + + +

 
  = − +    

 

 + + + +
 

 (37) 
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To proceed further the Clewlow model makes another simplifying assumption. The interest rates, dividend yields, 

volatilities, and time intervals are taken to be the same except for the next nearest fixing at 
1mt +
. This allows the 

derivation of analytical expressions for  TE M and 2

TE M   . 

In Eqn. (32) we separate out the factor depending on 
1mt + and set all remaining time intervals other than 

1mt + to 

the uniform value t . Eqn. (32) becomes 

 

  ( )

( )

( ) ( ) ( ) 

1

2 2

1

exp ( ) exp ( ) 1

exp ( )

exp ( ) exp 2( ) exp ( 1)( )

n k
t

T m

k m j m

t
m

S
E M r d t r d t

n

S
r d t

n

r d t r d t n m r d t

+

= + = +

+

 
= −  −  

 

= −  

−  + −  + + − − − 

 

 (38) 

Recognizing that the sum in brackets is a geometric sum of the form 

 

1
2 1

1

n
n r

c cr cr cr c
r

+−
+ + + + =

−
 (39) 

it follows that 

 ( )
( )

( )1

exp ( )( ) 1
exp ( )

exp ( ) 1

t

T m

S r d n m t
E M r d t

n r d t
+

 − −  −
  = −      −  − 

. (40) 

The evaluation of 2

TE M   is an extremely tedious exercise. We start by carrying out the multinomial expansion of 

the bracketed squared term in Eqn. (35) as follows: 

 

 

2

2 2 3 2 3

2 2 2

2 2 2 3

2 2 3

2 2

2 1

(1 )

1 2 2

2

m m m m m n

n n n

m i m i m m i

i m i m i m

n

m n i

i n

x x x x x x

x x x x x x x

x x x

+ + + + +

+ + + +

= + = + = +

+ −

=

+ + + + =

+ + + +

+

  



 (41) 

The expansion can be “visualized” as follows. The first two terms in the expansion in Eqn. (39) 2 2

2

2

1
n

m i

i m

x x+

= +

+ 

arise from the products between the terms illustrated below: 
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The next term 
2

2

2
n

m i

i m

x x+

= +

 arises from products of the form: 

 

There is a degeneracy of two since products of the form below contribute an identical sum: 

 

The third term 2

2 3

3

2
n

m m i

i m

x x x+ +

= +

 arises from products of the form: 

 

and, 

 

Finally, the last term 2 2

2 12
n

m n i

i n

x x x+ −

=

 comes from products of the form: 
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The expectation Eqn. (39) is given by, 

 

   

   

 

2

2 2 3 2 3

2 2

2 2

2 2

2

2 3

3

2 2

2 1

(1 )

1 2

2

2

m m m m m n

n n

m i m i

i m i m

n

m m i

i m

n

m n i

i n

E x x x x x x

E x E x E x E x

E x E x E x

E x E x E x

+ + + + +

+ +

= + = +

+ +

= +

+ −

=

 + + + + = 

   + + +   

  + 

   +    

 





 (42) 

This cumbersome expression can be simplified using the fact that,  

 1exp( ), for all 2, ,iE x i m n  = = +   (43) 

and 

 
2

2exp( ), for all 2, ,iE x i m n  = = +   (44) 

where 

 ( )2

1 2( ) , 2( )r d t r d t  = −  = − +   (45) 

The trick to simplifying the expression in Eqn. (40) is to repeatedly factor out a geometric summation using the 
formula in Eqn. (37). 

We evaluate the second term 2 2

2

2

n

m i

i m

E x E x+

= +

        in Eqn. (40): 

 

2 2 2 2 2

2 2 2 3

2

2 2 2

2 3

n

m i m m m

i m

m m n

E x E x E x E x E x

E x E x E x

+ + + +

= +

+ +

         = + +         

     +      


 (46) 

There are ( ( 2) 1) ( 1)n m n m− + + = − − terms in the right-hand side of the above equation. Replacing each 

expectation by Eqn. (42) we obtain: 
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2 2 22 ( 1)2 2

2

2

n
n m

m i

i m

E x E x e e e
  − −

+

= +

    = + + +     (47) 

This is a geometric summation so we can use Eqn. (37) 

 

2 2

2

( )

2 2

2

2 1

n mn

m i

i m

e e
E x E x

e

 



−

+

= +

−
    =   

−
  (48) 

Now we try and rearrange the remaining terms in Eqn. (42) into a geometric series, 

 

       

 

         ( )

         ( )

2

2 2 3

2 3

2 2

2 1

2 2 3 2

2

2 3 3 4 3

2 2

2 3

2 2

2

2

2

2

n n

m i m m i

i m i m

n

m n i

i n

m m m m n

m m m m m n

m m

E x E x E x E x E x

E x E x E x

E x E x E x E x E x

E x E x E x E x E x E x

E x E x

+ + +

= + = +

+ −

=

+ + + +

+ + + + +

+ +

 + + 

   + =   

+ + + +

  + + + + 

      

 



 (49) 

Using Eqns. (41) and (42) we have that, 

 

       

 

1 1 1 1 1 1

2 2

1 1 1

1 1

2

1

2

2 2 3

2 3

2 2

2 1

( ) ( 1) ( 2)
2

2
( 2)

2 2

2

2 2 2
1 1 1

2
1

n n

m i m m i

i m i m

n

m n i

i n

n m n m n m

n m

E x E x E x E x E x

E x E x E x

e e e e e e
e e

e e e

e e
e

e

     
 

  

 




+ + +

= + = +

+ −

=

− − − − −

− −

 + + 

   + =   

     − − −
= + + +          − − −     

−
+

−

 



 
  
 

 (50) 

We split the sum into two terms as follows, 

 

1 1 1 1 1 1

2 2

1 1 1

1 1

2

1

( ) ( 1) ( 2)
2

2
( 2)

1 2

2 2 2
1 1 1

2
1

n m n m n m

n m

e e e e e e
e e

e e e

e e
e S S

e

     
 

  

 




− − − − −

− −

     − − −
+ + +          − − −     

 −
+ = +  − 

 (51) 
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where, 

 ( )1 2 1 2 1 2 1

1

( ) ( 1) 2 ( 2) ( 2) 2

1

2

1

n m n m n m n m
S e e e e e e e

e

      



− − − − − − −
= + + + +

−
 (52) 

and 

 ( )
1

2 2 2

1

2 ( 2)

2

2
1

1

n me
S e e e

e


  



− −−
= + + + +

−
 (53) 

The sum 
2S comprises a geometric sum so we can directly apply Eqn. (37) to directly arrive at, 

 
( )

( )( )

1 2

1 2

( 1)

2

2 1

1 1

n m
e e

S
e e

 

 

− −
−

=
− −

. (54) 

Evaluation of the sum 
1S in Eqn. (51) requires a bit of manipulation to squeeze out a geometric sum as a factor. We 

first factor out a 12
e


term, 

 ( )
1

1 2 1 2 1 2

1

2
( 2) ( 3) 2 ( 4) ( 2)

1

2

1

n m n m n m n me
S e e e e e e

e


     



− − − − − − − −
= + + + +

−
 (55) 

Next we factor out the first term in the bracket, 

 

( )

( )

1 1

2 1 2 1 2 1

1

1 1

2 1 2 1 2 1

1

1 1 2 1

1 2 1

1 1

1

2 ( 2)
2 2 ( 2) ( 2)

1

2 ( 2)
( ) 2( ) ( 2)( )

2 ( 2) ( 1)( )

( )

2 ( 1)

2
1

1

2
1

1

2 1

1 1

2

n m
n m n m

n m
n m

n m n m

n m

e e
S e e e e e e

e

e e
e e e

e

e e e

e e

e e

e

 
     



 
     



   

  

 



− −
− − − − − −

− −
− − − − −

− − − − −

−

− −

= + + + +
−

= + + + +
−

 −
=   − − 

=
−( )

( )

2 1

2 11

1 2 1

2 11

( 1)( )

( )

2 ( 1) ( 1)

1

11

2
.

1

n m

n m n m

e

ee

e e e

e ee

 

 

  

 

− − −

−

− − − −

 −
  − 

 −
=   −−  

 (56) 

Putting together the results in Eqn. (47), (53), and (55) we have that Eqn. (40) is given by, 
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( )
( )

( )( )

1 2
2 2 1 2 1

2 2 11 1 2

2

2 2 3 2 3

( 1)
( ) 2 ( 1) ( 1)

(1 )

2 12
1 .

1 1 1 1

m m m m m n

n m
n m n m n m

E x x x x x x

e ee e e e e

e e ee e e

 
    

    

+ + + + +

− −
− − − − −

 + + + + = 

− − −
+ + +  − −− − − 

 (57) 

It follows that from Eqn. (35) that, 

 

( )

( )
( )

( )( )

1 2
2 2 1 2 1

2 2 11 1 2

2

2 2

1

( 1)
( ) 2 ( 1) ( 1)

exp (2( ) )

2 12
1 .

1 1 1 1

t
T m

n m
n m n m n m

S
E M r d t

n

e ee e e e e

e e ee e e

 
    

    

 +

− −
− − − − −

 
  = − +    

 

 − − − + + +   − −− − −  

 (58) 

If the average price call option (APO) depends on the forward price we need to set d r= in the formulas for  TE M  

and 2

TE M   in Eqn. (38) and (57). Unfortunately, the formulas diverge for d r= so we need to derive the limits as 

d r→ . 

Using L’Hopital’s rule we have that, 

  
( )

lim t
T

d r

S n m
E M

n→

−
=  (59) 

The limiting expression for 2

TE M   is given by, 

 

lim
𝑑→𝑟
𝐸 [𝑀𝑇

2
]= (

𝑆𝑡
𝑛
)
2
𝑒𝑥𝑝(𝜎2∆𝑡𝑚+1)

(

 
 
(1+𝑒𝜎

2∆𝑡)(𝑒
((𝑛−𝑚)𝜎2∆𝑡)

−1)+2(𝑛−𝑚)(1−𝑒𝜎
2∆𝑡)

(𝑒𝜎
2∆𝑡−1)

2

)

 
 

 (60) 

 

Pricing Formulas for London Metal Exchange APO Contracts 

Let n be the number of asset price fixings which corresponds to the number of business days in the contract month. 

The time to the next fixing is 
1mt + whereas the uniform time interval for all subsequent fixings is given by t . This 

uniform time interval should be set to, 

 
1n mt t

t
n

+−
 = . (61) 

Let 
TA denote the sum of the known part 

kA and stochastic part 
TM  of the average of asset prices given in Eqn. 

(17), 
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T T kA M A= +  (62) 

The expectations TE A   and 2

TE A   are given by 

 T T kE A E M A   = +     (63) 

and 

  2 2 22T T k T kE A E M A E M A   = + +    (64) 

Assuming
TA is log-normally distributed the formulas for a and b in Eqn. (24) and (25) can be written in terms of the 

above expectations, 

 
21

2
2ln lnT Ta E A E A   = −     (65) 

 
22ln lnT Tb E A E A   = − +     (66) 

The pricing model for calls and puts in the Black-Scholes framework is: 

 

( )

( )

( )

1 2

( )

2 1

( ) ( )

( ) ( )

r T t

T

r T t

T

C e E A N d KN d

P e K N d E A N d

− −

− −

 = − 

 = − − − 

 (67) 

 
1

2 1

1
ln

2

TE A
b

K
d

b

d d b

     +
 
 =

= −

 (68) 

 
2 1ln 2lnb E E= −  (69) 

 
1

1

( ) 1
, ( )

n

k t k

k m

F n m
E A F F t

n n m = +

−
= + =

−
  (70) 

 
2 3 4 5E E E E= +  (71) 

 

2

2

3 1exp( )m

F
E t

n
 +

 
=  
 

 (72) 
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 ( )

2 2 2

2

(( ) )

4

(1 )( 1) 2( )(1 )
,  for 1

1

1, for 1

t n m t t

t

e e n m e
m n

E e

m n

  



 −  



 + − + − +
 −

= −


= −

 (73) 

 
2

5

( )
2 k k

F n m
E A A

n

−
= +  (74) 
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Appendix A: Moments of a lognormal variable 

Let x be a lognormal variable so that, 

 ln ( , )x N a b  (75) 

where a is the mean and b is the variance. The probability density function of x  is given by 

 
2(ln ) /(2 )1

( )
2

x a bP x e
x b

− −=  (76) 

The raw moments of x are given by: 

 
21 ( ln ) /(2 )

0

1

2

k k x a bE x x e dx
b



− − −  =    (77) 

  22ln lnT Tb E M E M = − +  Making the change of variables lny x= we obtain 

 

2( 1) ( ln ) /(2 )

2

2

2 2

2 2

1

2

1 ( )
exp

22

1 ( ) 2
exp

22

1 2 2
exp

22

1 (2 2 )
exp exp

2 22

exp

k y k x a b yE x e e e dy
b

y a
ky dy

bb

y a bky
dy

bb

y ay a bky
dy

bb

a y a bk y
dy

b bb

a













− − −

−



−



−



−



−

  = 

 −
= − + 

 

 − − +
=  

 

 − + − +
=  

 

   − + +
= −   

   

= −











2 2 2

2 2 2 2

2

( ) 1 ( ( ))
exp exp

2 2 22

2
exp exp

2 2

exp
2

a bk y a bk
dy

b b bb

a a abk b k

b b

b
ka k





−

     + − − +
     
     

   + +
= −   

   

 
= + 

 



 (78) 
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This pricer covers OTCOption2LTBlack valuating it by application of the lognormal Black & Scholes model. 

It uses known analytical formulas to cover pricing of the different subtypes available within the 
CommodityOTCOption2. 

 

The following references are provided as a contrast reference. Actual implementation can vary slightly in order to 
obtain improved performance or accuracy. 

 

Haug, E.G. The Complete Guide to Option Pricing Formulas 2nd edition. New York: Mc-Graw Hill. 2006. p 7-9  

 

Haug, E.G. The Complete Guide to Option Pricing Formulas 2nd edition. New York: Mc-Graw Hill. 2006. p 174, 175 

 

Haug, E.G. The Complete Guide to Option Pricing Formulas 2nd edition. New York: Mc-Graw Hill. 2006. p 152-155 

 

Turnbull, S. L. & Wakeman, L. M., A Quick Algorithm for Pricing European Average Options, Journal of Financial and 
Quantitative Finance, 26, 377-389. (1991). 

Levy, E., Pricing European Average Rate Currency Options, Journal of International Money and Finance, 14, 474-
491. (1992) 

 

Unlike other exotic payouts, the case of Average Rate options requires an approximation, since exact analytical 
formulas are not available. 

The approach chosen in this case is the lognormal approximation suggested by Levy and Turnbull. Turnbull 
presented the possibility of approximating the distribution of the average by matching its known moments, while 
Levy refined the idea and suggested that just matching the first two moments with a lognormal distribution is 
sufficiently good in the majority of cases. This reduces the pricing to a direct application of the Black formula on 
the forward price, only that using an “adjusted” Asian volatility. 

A brief summary of the calculations is presented. 

Let 
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number of fixings

number of realized fixings

( ) forward price at time  for fixing date t k k

n

m

F t t t

=

=

=

 

 

We define the realized average by  

 
REL

1

1 m

k

k

A S
m =

=   (79) 

and the float average by 

 
FLT

1

1
( )

n

t k

k m

A F t
n m = +

=
−

  (80) 

Define the float variance by 

 ( )FLT ' '2
1 ' 1

1
var ( ) ( ) exp min( , ) 1

n n

t j t j j j j j

j m j m

F t F t t t
n

 
= + = +

 =   −
    (81) 

The adjusted “Asian” volatility is given by 

 

FLT

2

var
ln 1

A

n

A

t t


 
+ 

 =
−

 (82) 

where 

 1
REL FLT( ( ) )

n
A mA n m A= + −  (83) 

 

Now we can use the Black formula to calculate call option prices where the arguments to the normal cumulative 
functions are. 

 

 
1

2 1

ln( / ) 1
( )

( ) 2

( )

A n

A n

A n

A K
d t t

t t

d d t t






= + −
−

= − −

 (84) 

 


